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Identifier GUID-5373D6F9-22D5-4EB4-9197-66BAFEE0717C
Status Released

CHAPTER 1

Installing the Virtual Appliance

This chapter includes the following topics:

l Dell EMC SRM virtual appliance installation overview.........................................10
l Installing the 4VM vApp.......................................................................................11
l Install additional DELL EMC SRM vApp VMs overview....................................... 13
l Deploy Scaleout VMs in Existing vApp................................................................15
l Deploying Collector vApp VMs in different datacenters......................................16
l Post deployment, pre-startup tasks....................................................................18
l Adjusting the VMs.............................................................................................. 18
l Adding disk space............................................................................................... 19
l DataStores......................................................................................................... 19
l Modifying the start order of the vApps.............................................................. 20
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Identifier GUID-5777A4EA-4271-4B67-9DF3-62F4080EDA2E

Status Released

Dell EMC SRM virtual appliance installation overview
You can install Dell EMC SRM as a virtual appliance (vApp) in a supported VMware
environment. This guide describes the deployment process using the vSphere vCenter
Client. The Dell EMC SRM vApp can also be installed using the vSphere Web-based
Client, but the details are different and not in this guide.

When you deploy the Dell EMC SRM vApp on a cluster of ESX servers, the vCenter
DRS function (Cluster features) must be enabled. If it is not enabled in the vCenter
environment, set DRS to on and set the vCenter DRS Automation level to Manual.
After you complete the Dell EMC SRM deployment, you can disable the DRS function.

The vApp is based on SuSE Enterprise SLES 11 SP4.

The MySQL version included with the product is 5.7.21 MySQL Community Server
(GPL).

Do not add any binary VMs into the vApp container (including any Dell EMC SRM
binary VMs).

The procedures enable you to install two types of software:

Core software

The core software is a reporting solution that is built on a scalable architecture of
backends, frontends, and distributed collectors. When you install the core
software, you establish the foundation for the product, which provides common
capabilities, functions, and user interfaces. In addition, the following separate
software products are pre-installed with DELL EMC SRM: DELL EMC SRM 4.3
SOFTWARE IMAGE (453-010-807) and SLES 11 SP4 SW GPL3 OPEN SOURCE
SOFTWARE (453-010-808).

SolutionPacks

SolutionPacks are software components that support EMC and third-party
storage infrastructure components. Each SolutionPack enables you to select a
specific report in the UI. To learn more about the SolutionPacks that Dell EMC
SRM supports, see the following documents:

l Dell EMC SRM Support Matrix

l Dell EMC SRM Release Notes

l Dell EMC SRM SolutionPack Guide

Dell EMC SRM vApps are distributed using Open Virtualization Format (OVF) files.
Depending on the environment's requirements, use the 4VM vApp OVF or the 1VM
vApp OVF files.

4VM vApp OVF

Enables you to install four VMs (Frontend, Primary Backend, Additional Backend,
and one Collector). A vApp VM includes an ADG directory that is used by the
autoconfiguration process of the vApp VMs. The 4VM vApp automatically
configures the Collector host to have 48 GB of memory and 8 CPUs. The
following SolutionPacks are pre-installed on the Collector host:

l Brocade FC Switch

Installing the Virtual Appliance
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l Cisco MDS/Nexus

l DELL EMC Isilon

l DELL EMC Unity/VNX/VNXe

l DELL EMC VMAX

l DELL EMC VMAX / PowerMax

l VMware vCenter

l DELL EMC VPLEX

l DELL EMC XtremIO

l Block Chargeback

l DELL EMC M&R Health

l Strorage Compliance

1VM vApp OVF

Enables you to install a single vApp VM. The options are Frontend, Primary
Backend, Additional Backend, Collector, and All-in-One. You can use this option
to install additional Collectors and Additional Backend VMs to scale out the
existing Dell EMC SRM installation. You can add a single vApp VM (Collector or
Additional Backend) to an existing vApp container that was created with the 4VM
vApp. When you restart the vApp container, the new VMs are autoconfigured into
Dell EMC SRM. vApp VMs include an ADG directory that is used by the
autoconfiguration process. You can also use the 1VM vApp for small All-In-One
proof of concept solutions.

The Collector host that is deployed with the 1VM is configured with 32 GB of memory
and 4 CPUs.

Dell EMC SRM vApp VMs have properties that are used to configure the host level
networking information. If the vApp VM/folder has to be moved from one vCenter to
another, you must use the vCenter export and import procedure. Do not use the
vCenter remove from inventory method. For additional details, see Guidelines for
Managing VMware vApp Solutions (h15461).

Dell EMC SRM vApps fully support the VM vMotion and Storage vMotion DRS
functions of vCenter.

Identifier GUID-5152A9C5-CAD8-4705-92CF-4A3E9F7BA9C1

Status Draft

Installing the 4VM vApp
You can deploy the Dell EMC SRM 4VM appliance from an OVF template using a
vCenter Client. The installer creates the vApp container and deploys 4 vApp VMs
(Frontend, Primary Backend, Additional Backend, and one Collector) inside the vApp
container.

Before you begin

l If you are installing Dell EMC SRM on a cluster of ESX Servers, VMware DRS
(Distributed Resource Scheduler) must be enabled.

l Gather the following information:

Installing the Virtual Appliance
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n vCenter location where you plan to deploy the appliance

n A single DataStore is needed for deployment. After completing the deployment,
you can use Storage vMotion to move the VM's storage to different
DataStores. Dell EMC provides the final storage size per VM.

n Static IP address for each VM. This IP address must be registered in DNS with
forward and reverse lookup before you begin the deployment.

n Gateway

n Netmask

n DNS servers

n Domain search strings. For a distributed Dell EMC SRM environment, the
domains for all the Dell EMC SRM servers must be entered for each of the Dell
EMC SRM servers.

Procedure

1. Browse to the Support by Product (https://support.emc.com/products/
34247_ViPR-SRM) page for Dell EMC SRM .

2. Click Downloads.

3. Download the DELL EMC SRM <version number> vApp Deployment Zip
file.

Each download has a checksum number. Copy the checksum number and
validate the integrity of the file using an MD5 checksum utility.

The host being connected to the vCenter should be local to the ESX servers for
the quickest deployment. Locate the 4VM OVF deployment file on the host
running the vCenter client or place the files on the DataStore.

4. Open vCenter Client and connect to the vCenter Server that manages the
VMware environment.

Do not run vCenter Client on a VPN connection.

For the fastest deployment time, the host running vCenter Client should be
local to the ESX servers.

5. Select where in the vCenter ESX cluster/server you want to deploy the VMs for
Dell EMC SRM.

6. Select File > Deploy OVF Template.

7. In the Source step, locate the 4VM OVF template file.

8. Click Next.

9. In the OVF Template Details step, review the details of the loaded OVF file,
and then click Next.

10. In the End User License Agreement step, review the license agreement. Click
Accept, and then click Next.

11. In the Name and Location step:

a. Specify a new name or accept the default name for the appliance.

b. Specify an inventory location for the appliance in the VMware environment.

c. Click Next.

12. Select the Resource Pool or the folder where the deployment will place the
ViPR SRM VMs, and click Next in the Resource Pool step.

Installing the Virtual Appliance
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13. In the Storage step, select the destination storage (DataStore) for the virtual
machine files and click Next.

The compatibility window states if there is insufficient disk space on the
selected DataStore, and a warning is displayed when you click Next.

14. In the Disk Format step, select the storage space provisioning method, and
then click Next.

Option Description

Thin-provisioned
format

On-demand expansion of available storage, which is
used for newer data store file systems.

Thick-provisioned
format

Appliance storage that is allocated immediately and
reserved as a block.

Note

DELL EMC SRM is fully supported on thin-provisioned storage at the array or
virtualization level. Thin on thin is acceptable, but not recommended.

15. In the Network Mapping step, select a destination network for all of the VMs,
and then click Next.

With ViPR SRM 4.2, the only option is to place all 4 VMs on the same ESX
server network. It is known as the simplified network deployment.

16. In the IP Address Allocation step, choose the IP allocation policy and IP
protocol to use, and then click Next.

17. In the Properties step, provide the values for each of the VMs, and then click
Next.

18. In the Ready to Complete step, review the list of properties for the appliance,
and then click Finish.

A pop-up window opens in vCenter Client showing the deployment progress.

19. After the 4VM deployment finishes, in the Deployment Completed
Successfully dialog box, click Close.

20. Before you power on the vApp, make the following changes to the VM
configurations:

l To expand the file system, add additional VMDK disks.

l Adjust the vCPU and VM Memory as specified in the DELL EMC SRM
design.

21. Use the 1VM OVF to add any Additional Backend VMs and Collector VMs as
described in the following section.

Identifier GUID-F817B29A-7050-40A7-9C9B-85D8B6093D09

Status Released

Install additional DELL EMC SRM vApp VMs overview
You can scale DELL EMC SRM larger by adding additional databases (Additional
Backends), Collectors, and slave Frontends. Use this procedure to deploy the
additional VMs are required to scale the DELL EMC SRM environment. This process

Installing the Virtual Appliance
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includes adding Additional Backend and Collector VMs to the existing DELL EMC SRM
vApp container and deploying Collector vApp VMs in different data centers.

For POC and lab installs, an All-In-One solution is available. (The All-In-One solution is
not supported for managing production environments because it does not scale.)

When you deploy the Dell EMC SRM vApp on a cluster of ESX servers, the vCenter
DRS function (Cluster features) must be enabled. If it is not enabled in the vCenter
environment, set DRS to on and set the vCenter DRS Automation level to Manual.
After you complete the Dell EMC SRM deployment, you can disable the DRS function.

The vApp is based on SuSE Enterprise SLES 11 SP4.

The MySQL version included with the product is 5.7.21 MySQL Community Server
(GPL).

Do not add any binary VMs into the vApp container (including any DELL EMC SRM
binary VMs).

The procedures enable you to install two types of software:

SolutionPacks

Software components that support DELL EMC and third-party storage
infrastructure components. Each SolutionPack enables you to select a specific
report in the UI. To learn more about the SolutionPacks that Dell EMC SRM
supports, see the following documents:

l Dell EMC SRM Support Matrix

l Dell EMC SRM Release Notes

l Dell EMC SRM SolutionPack Guide

Dell EMC SRM vApps are distributed using Open Virtualization Format (OVF) files.
Use the 1VM vApp OVF files to scaleout Additional Backends, Collectors, and
Frontends.

1VM vApp OVF

Enables you to install a single vApp VM. The options are All-in-one, Frontend,
Additional Backend, Collector, and Minimal . You can use this option to install
additional Collectors and Additional Backend VMs to scale out the existing Dell
EMC SRM installation. You can add a single vApp VM (Collector or Additional
Backend) to an existing vApp container that was created with the 4VM vApp.
When you restart the vApp container, the new VMs are automatically configured
into ViPR SRM. vApp VMs include an ADG directory that is used by the automatic
configuration process.

DELL EMC SRM vApp VMs have properties that are used to configure the host level
networking information. If the vApp VM/folder has to be moved from one vCenter to
another, you must use the vCenter export and import procedure. Do not use the
vCenter remove from inventory method.

DELL EMC SRM vApps fully support the VM vMotion and Storage vMotion DRS
functions of vCenter.

Installing the Virtual Appliance
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Identifier GUID-083FDA93-885F-4533-ACDA-8DCE12B28961

Status Draft

Deploy Scaleout VMs in Existing vApp
DELL EMC SRM supports adding additional backends and collectors either inside or
outside of the SRM vApp. Use this procedure to deploy scaleout VMs inside of the
SRM vApp.

Before you begin

1. Log in to the vCenter managing the vApp you want to scale out.

2. Right-click the vApp and select Shut Down. Wait for all VMs in the vApp to shut
down completely.

Procedure

1. Browse to the Support by Product page for DELL EMC SRM (https://
support.emc.com/products/34247_ViPR-SRM) page.

2. Click Downloads.

3. Download the DELL EMC SRM <version number> vApp Deployment Zip
file.

The host being connected to the vCenter should be local to the ESX servers for
the quickest deployment. Locate the 1VM OVF deployment file on the host
running the vCenter client or place the files on the DataStore.

4. Open the vSphere Client and connect to the vCenter Server that manages the
VMware environment.

5. Select the resource pool where you want to deploy the VMs for DELL EMC
SRM.

6. Select File > Deploy OVF Template.

7. In the Source step, locate the 1VM OVF file.

8. Click Next.

To save time, deploy the appliance in the same local area network (LAN) that
the VMware ESX/ESXi servers share. Deployment takes approximately 5
minutes to 15 minutes. Deployment across a WAN can take 2 hours or more.

9. In the OVF Template Details step, review the details of the loaded .ovf file
and click Next.

10. In the End User License Agreement step, review the license agreement, click
Accept, and then click Next.

11. In the Name and Location step, accept the default name (DELL EMC SRM) or
type a Name for the appliance. Specify an Inventory Location for the appliance
in the VMware environment. Click Next.

12. Select the host or cluster where you want to run the deployed template and
click Next.

13. Select the destination storage for the virtual machine files and click Next.

14. In the Disk Format step, select the storage space provisioning method and click
Next.

Installing the Virtual Appliance
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Option Description

Thin-provisioned
format

On-demand expansions of available storage, which is
used for newer data store file systems.

Thick-provisioned
format

Appliance storage that is allocated immediately and
reserved as a block.

Note

EMC recommends the thin-provisioned format option when the vApp is
deployed in a high-performance environment.

15. In the Network Mapping step, select a destination network that has an IP Pool
that is associated with it for each of the VMs and click Next.

16. In the IP Address Allocation step, choose the IP allocation policy, the IP
protocol to use, and click Next.

17. In the Properties step, provide the values for each of the VMs, and click Next.

18. In the Ready to Complete step, review the list of properties for the appliance
and click Finish.

A status bar opens in the vSphere Client showing the deployment progress.

19. Click Close in the Deployment Completed Successfully dialog box.

Results

1. Wait for all VMs to complete deployment.

2. Modify the start order of the vApp entities as described in Modifying the start
order of the vApps on page 20.

3. Power on vApp after all deployments are completed. Right-click the vApp and
select Power On.

A built-in service detects the new VMs and performs the needed configurations.

Identifier GUID-099B61BE-34AF-439B-8AF2-8FE7B243724D

Status Draft

Deploying Collector vApp VMs in different datacenters
Use this procedure to deploy remote Collectors in different datacenters.

Procedure

1. Browse to the Support by Product (Support by Product) page for DELL EMC
SRM.

2. Click Downloads.

3. Download the DELL EMC SRM <version number> vApp Deployment Zip
file.

Each download has a checksum number. Copy the checksum number and
validate the integrity of the file using an MD5 checksum utility.

The host being connected to the vCenter should be local to the ESX servers for
the quickest deployment. Locate the 1VM OVF deployment file on the host
running the vCenter client or place the files on the DataStore.

Installing the Virtual Appliance
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4. Open the vCenter Client and connect to the vCenter Server that manages the
VMware environment.

5. Select File > Deploy OVF Template.

6. In the Source step, locate the 1VM OVF file.

7. Click Next.

8. In the OVF Template Details step, review the details of the loaded .ovf file, and
click Next.

9. In the End User License Agreement step, review the license agreement. Click
Accept, and then click Next.

10. In the Name and Location step:

a. Specify a new name or accept the default name for the appliance.

b. In the Inventory Location, select the Datacenter and sub-location where the
appliance is deployed. To define the exact location, browse through the
folder levels.

c. Click Next.

11. In the Deployment Configuration step, select the Collector Appliance from the
drop-down list.

12. In the Host/Cluster step, select the ESX server or ESX Cluster, and click Next.

13. In the Resource Pool step, select the Resource Pool or the folder where the
deployment places the Dell EMC SRM VMs, and click Next.

14. In the Storage step, select the DataStore for the virtual machine files, and then
click Next.

15. In the Disk Format step, select the storage space provisioning method, and
then click Next.

Option Description

Thin-provisioned
format

On-demand expansions of available storage, which is
used for newer data store file systems.

Thick-provisioned
format

Appliance storage that is allocated immediately and
reserved as a block.

16. In the Network Mapping step, select a destination network for the VM, and
then click Next.

17. In the IP Address Allocation step, choose the Fixed IP allocation policy and the
IP protocol to use, and then click Next.

18. In the Properties step, provide the values for each field, and then click Next.

19. In the Ready to Complete step, review the list of properties for the appliance,
and then click Finish.

A menu that shows the deployment progress opens in vCenter Client.

20. After the deployment finishes, in the Deployment Completed Successfully
dialog box, click Close.

21. Repeat these steps for each Collector that is required to install in a remote
datacenter.

22. Before you power on the vApp, make the following changes to the VM
configurations:

Installing the Virtual Appliance
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a. To expand the file system, add additional VMDK disks.

b. Adjust the vCPU and VM Memory as specified in the DELL EMC SRM
design.

23. If you are adding a remote collector that is deployed in a remote datacenter to
the DELL EMC SRM vApp, use the steps for adding a collector that is described
in Dell EMC SRM configuration tools on page 32. These steps finish the
collector configuration and add the collector to the DELL EMC SRM UI.

Results

For Collectors installed in a remote datacenter, you are required to use the ViPR SRM
UI to make some configuration changes to the Load Balancer Connectors, generic-rsc,
and generic-snmp installed on each Collector.

Identifier GUID-F383B4D1-2F43-41D4-9F4D-6167809F5775

Status Draft

Post deployment, pre-startup tasks
After you have deployed the vApp VMs, but before you start DELL EMC SRM, you
must make some configuration changes as specified in the DELL EMC SRM design
that is provided by EMC.

To complete the configuration changes:

Procedure

1. Adjust the Collector VM memory.

2. Adjust the Collector VM CPUs.

3. To conform to naming policies, change the vApp VM name in vCenter.

4. Increase the VM storage per VM.

5. Move the vApp VM storage to its assigned datastore.

6. Modify the vApp container startup order.

Identifier GUID-37D362EE-06B8-4601-88A1-EA9018000A9E

Status Draft

Adjusting the VMs
The Collectors (and possibly the Frontend) need the number of CPUs, the size, and
the memory adjusted based on the DELL EMC SRM design. To make these updates,
edit the settings of each Collector vApp VM.

Procedure

1. Change the vApp VMs name to default VM to meet VM naming standards.

2. Edit the VM settings and select the Options tab to make the updates.

Installing the Virtual Appliance
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Identifier GUID-F9DDD49B-17D3-4FE4-A825-2314B31C66D8

Status Draft

Adding disk space
All vApp VMs are deployed with 132GB of storage. Each Dell EMC SRM VM needs
larger storage. The total Dell EMC SRM VM storage size is based on the Dell EMC
SRM design. Edit the settings of each vApp VM and add a VMDK (virtual machine
disk). Subtract 132 GB from the total storage size that is specified in the sizing plan
that is provided by EMC, and add a VMDK (virtual machine disk) with the size of the
additional storage needed. The VM can be running during this process.

Procedure

1. From the vCenter Console, select the individual VM where you want to add new
disk storage.

2. Select Edit Settings on the virtual machine and click Add.

3. Select Hard Disk and click Next.

4. Select Create a new virtual disk and click Next.

5. Specify the disk size, the provisioning type, the location of the disk and click
Next.

6. Specify the virtual device node (the default value should be OK) and click Next.

7. Review the options and click Finish.

8. After DELL EMC SRM is up and running, connect to the Linux host. You can
access a login prompt through the vCenter Client console or using an SSH tool
such as PuTTY.

9. At the root command prompt, type the command expand_disk.pl.

The script merges the new VMDK with the existing files system while the VM is
still running. Use the df -h command when the script is finished to see the
new file system size.

Identifier GUID-BE739EA3-FF85-4C34-AD10-02C0E2D51304

Status Released

DataStores
The 4VM vApp deployment places the 4 VMs on a single DataStore. Migrate the VM
from this DataStore to its assigned DataStore. The required storage per DELL EMC
SRM VM can be found in the design that is provided by EMC.

For reference, the target storage sizes are as follows:

l Frontend – 320 GB

l Primary Backend – 800 GB and larger

l Additional Backends – 1 TB and larger

l Collector – 300 GB or larger

With the VM in a powered off state, use the Storage vMotion feature to move the VM
to a new DataStore.
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Identifier GUID-B1C746F4-1C44-4A4C-96EC-1E49B0D03E36

Status Draft

Modifying the start order of the vApps
Modify the start order of the vApps in a DELL EMC SRM installation whenever you
add a vApp VM to the vApp container.

Procedure

1. Right-click the vApp and select Edit Settings.

2. Browse to the Start Order tab.

3. Move the new VMs into the proper group that is based on the following:

l Group 1: All Additional Backends

l Group 2: Primary Backend

l Group 3: All Collectors

l Group 4: Frontend

4. In the Shutdown Action section, select Guest Shutdown from the Operation
list.

5. Change the elapsed time to 600 s.

6. Click OK.
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CHAPTER 2

Using the Dell EMC SRM Setup Wizard

This chapter includes the following topic:

l Using the Discovery Wizard............................................................................... 22
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Using the Discovery Wizard
The Discovery Wizard is a tool to ease the initial deployment and configuration of the
most commonly used SolutionPacks. After upgrading to ViPR SRM 4.2 or later, you
may want to use the Discovery Wizard to quickly enable the SolutionPacks and add
the corresponding devices that you would like to report on. In a few simple steps you
can now add the devices, monitor the collection process, and then go to the reports to
see the data.

These steps use the VMAX 3/VMAX All Flash SolutionPack as an example.

Procedure

1. Log in to the user interface at https://<Frontend-hostname>:58443/
APG.

The default username is admin. The default password is changeme.

2. Access the Discovery Wizard from admin page: Administration> DISCOVERY >
Discovery Wizard .

3. On the License page, do one of the following and click Continue.

l You can add a permanent license by drag-and-dropping the file onto the
license box.

4. On the Storage Collection page, do the following and click Continue.

a. Type the FQDN or IP address of the Unisphere for VMAX host.

b. Type the login credentials and port number.

5. On the Confirm Storage page lists the detected arrays , .

a. Select the arrays from which you want to collect data.

The meter at the bottom indicates how many more volumes you can collect
before you exceed the limit.

b. Click Start Collection & Continue when you have finished adding arrays

Note

The Confirm Storage page only applies to VMAX systems.

6. On the Fabric Collection page, select Brocade (SMI-S) or Cisco (SNMP)
from the drop-down list. Type the credentials and configuration options for the
switch. Click Start Collection & Continue.

Brocade SAN discovery with this wizard is through Brocade SMI-S only. This
solution provides limited switch performance and topology information with
WWNs. The Brocade SMI-S Data Collector that is deployed with the 4VM
Collector is configured to discover everything through SMI-S. When you deploy
the Brocade SolutionPack, the SMI-S Data Collector is configured to restrict
the data collection to zoning only. It is a best practice to discover the Brocade
SAN using SMIS-S for zoning and SNMP for everything else. It provides
performance metrics and the topology shows friendly names.
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7. On the Fabric Collection page, select Brocade (SNMP+SMI-S) or Cisco
(SNMP) from the drop-down list. Type the credentials and configuration
options for the switch. Click Start Collection & Continue. .

Brocade SAN discovery with this wizard is through Brocade SMI-S & SNMP.
This solution provides limited switch performance and topology information with
WWNs. The Brocade SMI-S Data Collector that is deployed with the 4VM
Collector is configured to discover everything through SMI-S & SNMP. When
you deploy the Brocade SolutionPack, the SMI-S Data Collector is configured
to restrict the data collection to zoning only. It is a best practice to discover the
Brocade SAN using SMIS-S for zoning and SNMP for everything else. It
provides performance metrics and the topology shows friendly names.

8. Click Start Collection and Continue on the Compute Collection page, type
the credentials for the VMware vCenter Server.

9. The Collection Status page displays the status of the data collection and
provides links to next steps. Click Restart to repeat this process for each of the
device types.

10. Remove any pre-installed SolutionPacks and collectors that you do not plan to
use:

a. Access the UI at https://<Frontend-hostname>/APG.

b. Type the login credentials.

The default username is admin. The default password is changeme.

c. Browse to Administration > Discovery > SolutionPacks.

d. Click the SolutionPack that you want to uninstall.

e. Click the Trashcan icon for each component.

f. Click Remove.

11. Refer to the DELL EMC SRM SolutionPack Guide for details about installing
SolutionPacks that were not pre-installed.

Using the Dell EMC SRM Setup Wizard
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CHAPTER 3

Working with Dell EMC SRM

This chapter includes the following topics:

l Starting the vApp...............................................................................................26
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l Logging in to the user interface......................................................................... 28
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Starting the vApp
The vApp container settings control the Dell EMC SRM startup order.

Before you begin

Edit the start-up as described in Post deployment, pre-startup tasks on page 18.

Always start and stop the vApp using the vApp container. Do not stop any of the
individual VMs inside the vApp container. You can start and stop Remote Collectors in
other datacenters independently. Use vCenter Client to start the vApp.

The initial startup of Dell EMC SRM takes about 10 minutes for the VMs to be shown
as started in vCenter, because it requires an internal configuration process to
configure each VM completely. You can monitor this process by opening the vCenter
Console for the VM.

Procedure

1. Dell EMC SRM will be ready for login after the additional background
processing completes.

2. Log in to the URL https://<Frontend-hostname>:58443/APG.
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Dell EMC SRM Passwords
Passwords control access to Dell EMC SRM and the internal communications.

The web-based user passwords are managed through the Administration user
interface. The Dell EMC SRM internal communications passwords are managed
through the System Admin > Settings > Central Configuration Repository. For
additional details, refer to the Security Configuration Guide.

Table 1 Default usernames and passwords

Environment Default username and password

Web-based console that is accessed in a
browser

admin/changeme. Ensure that you change

this password.

ws-user watch4net

MySQL watch4net

apg user watch4net

MySQL root user watch4net

Linux guest OS appliance console that is
accessed through SSH or vCenter

root/Changeme1!

If you choose to change the root user password, the password must conform to the
following requirements:
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l Be at least eight characters and no more than 40 characters

l Contain at least one numeric character

l Contain at least one uppercase and one lowercase character

l Contain at least one non-alphanumeric character such as # or !

l Cannot contain the single quote character (') because it is a delimiter for the
password string

Note

The web-based requirements do not apply to Linux passwords.
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Verifying that the services are running
Verify that the services are running on each host by obtaining the status.

Before you begin

Ensure that you have a login with root, APG, or system administrator privileges. The
user apg is the account that the application uses instead of root.
Procedure

1. Type the command for the operating system from the bin directory of the
installation:

Operating system Command

UNIX manage-modules.sh service status all
Windows manage-modules.cmd service status all

2. Verify that each service has a status of running in the output.
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Troubleshooting service start-up problems on UNIX
Check the log files when services do not start.

Before you begin

Ensure that you have logged in with root to check the log files.

Procedure

l The default path is /opt/APG/.

The list of available log files vary depending on the type of server (Frontend,
Backend, or Collector).

Databases/MySQL/Default/data/[SERVER NAME].err
Backends/Alerting-Backend/Default/logs/alerting-0-0.log
Backends/APG-Backend/Default/logs/cache-0-0.log
Collecting/Collector-Manager/Default/logs/collecting-0-0.log
Web-Servers/Tomcat/Default/logs/service.log
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Tools/Task-Scheduler/Default/logs/scheduler-0-0.log
Tools/Webservice-Gateway/Default/logs/gateway-0-0.log
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Logging in to the user interface
Log in to the user interface to use and edit reports, manage users, and customize the
interface to meet the needs.

Procedure

1. Open a browser and type the following URL:

https://<Frontend-hostname>:58443/APG
2. Type the login credentials.

The default username is admin. The default password is changeme.

3. Click Sign In.

Note

You are automatically logged off after 4 hours.
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Verifying MySQL DB Grants
After installing and configuring the DELL EMC SRM hosts, cross check the grant
privileges that are configured for the DELL EMC SRM servers that are listed in the
SRM-Conf-Tools configuration file.

Database grants for Collector hosts are not required.

Where the scripts configure grants for Collector hosts, it is not needed and can be
ignored or deleted.

Procedure

1. Run the following script:

/opt/APG/bin/mysql-client.sh 

2. When prompted, select root as the username, mysql for the database, and
watch4net as the password.

3. Run the following query:

mysql> SELECT user, host, db, select_priv, insert_priv, 
grant_priv FROM mysql.db;
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The following table is an example of the configuration you should see on an Additional
Backend host:
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CHAPTER 4

Dell EMC SRM Configuration Tools

This chapter includes the following topics:

l Dell EMC SRM configuration tools..................................................................... 32
l Creating the Dell EMC SRM-Conf-Tools answers file........................................ 32
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Dell EMC SRM configuration tools
Dell EMC SRM Configuration Tools (SRM-Conf-Tools) are installed with the Dell EMC
SRM software in the /opt/APG/bin directory. These tools work with both vApp and
binary deployments.

The SRM-Conf-Tools scripts use an answers file to automatically configure the Dell
EMC SRM servers. You can use the SRM-Conf-Tools for the following scenarios:

l Initial configuration of a Frontend, Primary Backend, and Additional Backend
servers

l Adding new Additional Backend servers to an existing ViPR SRM environment

l Adding new Collectors to an existing Dell EMC SRM environment

Before you begin, deploy all of the Collectors in all of the remote datacenters. They
can be Collector vApps, or binary Linux or Windows Collectors.

Binary Collectors are installed using the "Collector" install option for both Linux and
Windows. A Collector configuration script in SRM-Conf-Tools finishes the Collector
configuration so that it is the same as a vApp collector.

If an SRM-Conf-Tools script configuration fails, you cannot run the script a second
time. If the configuration fails, you must clean Dell EMC SRM from the server and
reinstall Dell EMC SRM. Refer to Uninstallation on page 67.

If you are using vCenter Snapshots, power off the VM and take a snapshot before
running the scale-tools script.
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Creating the Dell EMC SRM-Conf-Tools answers file
DELL EMC SRM-Conf-Tools is a command-line utility that can configure and add a
single server or multiple servers to the DELL EMC SRM environment. DELL EMC
SRM-Conf-Tools uses an answers file that you create that includes all of the DELL
EMC SRM hosts in all of the datacenters where DELL EMC SRM is installed.

Before you begin

l The answers file is case sensitive and must be all lowercase.

l Create the file using notepad++ or the Linux VI editor.

l Name the file srm—hosts.

The format of the answers file is: server_type=hostname:os
l server_type -The four basic types of DELL EMC SRM servers

l Hostname -The server's FQDN. It matches the setting of the hostname variable in
the apg.properties file. For Linux servers, it should always be the hostname
plus the domain name (FQDN). For Windows, it could be the hostname
(shortname) or the FQDN depending on how the Windows server resolution is
configured (DNS, Active DNS, or Wins/NetBios). A Wins resolution uses the
hostname (shortname) in uppercase.
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l OS -linux-x64 or windows-x64

For example:

frontend=lglba148.lss.emc.com:linux-x64
primarybackend=lglba224.lss.emc.com:linux-x64
additionalbackend_1=lglac142.lss.emc.com:linux-x64
collector_1=lglba150.lss.emc.com:linux-x64

This answers file can be modified later to add any new Collectors and Additional
Backends. When the DELL EMC SRM-Conf-Tools scripts run, they distinguish new
servers from existing servers and make the necessary configuration changes.

Since the DELL EMC SRM-Conf-Tools and the answers file are used for configuring
additional servers at a later date, DELL EMC recommends storing the files in a /sw
directory in the / directory instead of the /tmp directory. This action should be
performed because the /tmp directory could be deleted at any time.
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CHAPTER 5

Configuring Remote Collectors

This chapter includes the following topics:

l Adding remote Collectors to the existing Dell EMC SRM deployment................36
l Reconfiguring the LBC, Generic-SNMP, and Generic-RSC................................37
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Adding remote Collectors to the existing Dell EMC SRM
deployment.

When you add a vApp Collector VM, it is completely configured as a Collector host
with all of the components. You can add the Collector through Administration System
Admin > Settings > Configure Servers > Register a Server. If you have multiple
remote vApp collectors, you can use the launch-frontend-scale-
collector.sh -c /sw/srm-hosts script to register the Collectors. For details
about using the SRM-Config-Tool, see ViPR SRM configuration tools.

Database grants for Collector hosts are not required.

Use the following procedure to add a binary Collector.

Note

For Windows, use .cmd instead of .sh, and / instead of \ for directories.

Procedure

1. Install the Dell EMC SRM software as described in Installing on Linux on page
41 or Installing on Windows Server on page 43.

2. Configure the binary collectors:

a. Browse to the following directory:

Linux: cd /opt/APG/bin
Windows: cd Program Files/APG/bin

b. Run the Collector configuration script:

launch-collector-configuration.sh –c /sw/srm-hosts

c. Verify that all of the services are running:

manage-modules.sh service status all

3. On the Frontend, run the following command:

launch-frontend-scale-collector.sh -c /sw/srm-hosts

4. Verify the Remote Collector configuration through the Dell EMC SRM UI.
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Reconfiguring the LBC, Generic-SNMP, and Generic-RSC
If a collector is powered on outside of the vApp, you must reconfigure the Load
Balancer Connector, generic-snmp, and generic-rsc.

Procedure

1. From Administration UI go toDiscovery, click SolutionPacks > Installed
SolutionPacks.

2. Under Manage Core Components , click the Reconfigure icon for a Load
Balancer Connector for each remote Collector. Use the following settings:

l Arbiter Configuration— send data to the Primary Backend over port 2020.

l Alerting on data collection— send data to the Primary Backend over port
2010.

l Frontend web service— send data to the Frontend over port 58080.

3. Repeat these steps for each remote Collector's Load Balancer Connector.

4. Under Manage Core Components , click the Reconfigure icon for a generic-
snmp or generic-rsc instance. Use the following settings:

l Data Configuration: send data to the localhost over port 2020.

l Frontend web service: send data to the Frontend over port 58080.

l Topology Service: send data to the Primary backend.

5. In the SNMP Collector Name field, type the FQDN of the collector host.

6. Repeat the steps for each instance of generic-snmp and generic-rsc.
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Installing Using the Binary Installer
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Installation options for a standard installation
Learn how to install the platform using a binary installation package.

The platform infrastructure consists of four types of hosts:

l Frontend host

l Backend hosts (Primary Backend and Additional Backend)

l Collector host

l All-In-One (recommended for POCs and testing only)

Note

You can only have one Primary Backend host. You can add Additional Backend hosts
with up to four Time-Series databases on each Additional Backend host. Use the Linux
operating system for DELL EMC SRM deployments with 5 million metrics or more,
EMC recommends that the core DELL EMC SRM hosts (Frontend, Primary Backend,
and Additional Backend hosts). The MySQL version included with the product is 5.7.21
MySQL Community Server (GPL).

Table 2 Installation Options

Installation
Options

Frontend Primary
Backend

Additional
Backend

Collector

Linux Installation
Options

[f]rontend [b]ackend [m]inimal [c]ollector

Windows
Installation
Options

Frontend
Modules

Backend
Modules

Base Installation
(with none of the
modules
selected)

Collector
Modules
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General Dell EMC SRM requirements
These requirements are for a minimal deployment. In a production environment, the
requirements vary depending on the provisioned load, and you must include careful
planning and sizing before beginning the deployment.

The ViPR SRM Workbench and the SRM 4.3.x Documentation document that is
associated with the specific release provides guidance for SolutionPacks and object
discovery.

For details about configuring CA SSL certificates, refer to the SRM 4.3.x
Documentation.

The environment must meet the following requirements:
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l 64 bit operating system (Linux or Windows)

l Frontend – 16 GB RAM, 4 CPUs, and 320 GB disk storage

l Backends – 24 GB RAM, 4 CPUs, and disk storage determined by the sizing

l Collectors – 16 GB to 64 GB RAM, 4 to 8 CPUs, and 130+ GB disk storage

l Forward and Reverse IP and DNS lookups must work on each server

Note

The following sections use Linux commands and directories as examples. For
Windows, use .cmd instead of .sh, and / instead of \ for directories.
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Linux requirements
The environment must meet the following requirements. Changes should be made to
the host, before continuing.

l /tmp folder larger than 2.5 GB

l SWAP file should be at least equal to the RAM size

l On CentOs or RedHat-like Linux, the SELinux should be disabled or reconfigured

l The graphical desktop environment is not required

l On some Linux distributions:

n MySQL server requires libaio1, libaio-dev, or libaio to start

n The installation process requires unzip

n On system, restart the apg services may not start
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Installing on Linux
You can install the product on supported UNIXLinux hosts. This procedure specifically
uses the Linux installation procedure as an example.

Before you begin

l Ensure that you have a login with root privileges. This product must be only
installed using root and root privileges

l Ensure that the ports that are listed in the Ports Usage Matrix are enabled and a
host or network firewall does not block them.
Refer to Updating firewall ports in Red Hat and CentOS servers.

l Download the installation file from support.emc.com, and place it in a folder
(for example /sw) on the server.

l MySQL DB is upgraded to 5.7.21 from SMR 4.2.1. MySQL 5.7.21 requires Libnuma
library to be installed on the system for binary installs on Linux platform. Install and
Upgrade to 4.3 fails without this library. This library is included in vApp. vApp
installation/Upgrade does not have this issue.
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These instructions are meant to provide a high-level overview of the installation
process. Detailed instructions are provided in the following sections.

Procedure

1. Log in to the server as root.

2. Browse to the /sw folder.

3. Change the permissions of the installer.

For example: chmod +x <file_name>.sh
4. Run the installer from the directory.

For example: ./<file_name>.sh
5. Read and accept the End User License Agreement.

6. Accept the default installation directory of /opt/APG or type another location.

7. Select the correct installation option for the type of host that you are installing.
Refer to Installation Options for details.
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Configuring the user process limits for a Linux installation
Increase the user process limits for the apg user account to a maximum of 65534. This
change enables services to open 65534 files and 65534 processes when needed. This
step is required for proper functioning of the core software.

Before you begin

l Ensure that you have a login with root privileges.

l The core software that is installed on a server running Red Hat Enterprise Linux 6,
CentOS Linux 6, SUSE Linux Enterprise Server (SLES) 11, or any other supported
Linux operating systems.

Procedure

1. Edit the security file: vi /etc/security/limits.conf.

2. Insert the following lines for the apg user below the line with #<domain>.

In this example, the user is apg.

apg   hard  nofile  65534
apg   soft  nofile  65534
apg   hard  nproc   65534
apg   soft  nproc   65534

3. Save the file.

4. To verify the changes, type the following command:

su apg -c 'ulimit -n -u'
open files                                  (-n)    65534
max user processes         (-n) 65534
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5. In the /opt/APG/bin/apg.properties file, edit the hostname to an FQDN
hostname:

#===================
# Common Properties
#===================
hostname=lglba148.lss.emc.com

6. To restart the services, type the following commands from the /opt/APG/bin
directory of the installation:

/opt/APG/bin/manage-modules.sh service stop all
/opt/APG/bin/manage-modules.sh service start all
/opt/APG/bin/manage-modules.sh service status all
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Configuring virus-scanning software
Running virus-scanning software on directories containing MySQL data and temporary
tables can cause issues, both in terms of the performance of MySQL and the virus-
scanning software misidentifying the contents of the files as containing spam.

After installing MySQL Server, it is recommended that you disable virus scanning on
the directory that is used to store the MySQL table data (such as /opt/APG/
Databases/MySQL/Default/data). In addition, by default, MySQL creates
temporary files in the standard temporary directory. To prevent scanning the
temporary files, configure a separate temporary directory for MySQL temporary files
and add this directory to the virus scanning exclusion list. To do it, add a configuration
option for the tmpdir parameter to the my.ini configuration file.
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Installing on Windows Server
You can install the product on supported Windows Server hosts.

Before you begin

l Ensure that the \tmp folder is larger than 2.5 GB.

l Ensure that you have a login with system administrator privileges.

l Ensure that the ports that are listed in the Ports Usage Matrix are enabled and the
firewall does not block them.

l Download the installation file from https://support.emc.com, and place it in a
folder (for example, c:\sw) on the server.

These instructions are meant to provide a high-level overview of the installation
process. Detailed instructions are provided in the following sections.

Procedure

1. Browse to the c:\sw folder.
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2. Double-click the .exe file.

3. Click Next on the Welcome screen.

4. Read and accept the End User License Agreement. Click I Agree.

5. Select the Destination Folder, and then click Next.

6. Select the correct installation option for the type of host that you are installing.
Refer to Installation Options for details.

7. Click Install.

8. When the installation is complete, click Next.

9. Click Finish.

10. Verify that the hostname is an FQDN hostname in the Program Files\APG
\bin\apg.properties file. If the hostname is a shortname, edit the file to
change the hostname to an FQDN.

11. STOP: Repeat the DELL EMC SRM installation and configuration process for all
of the servers in this deployment before proceeding.

12. Verify that the first uncommented line is this host's IP address, FQDN, and
shortname in c:\windows\System32\drivers\etc\hosts file. If it is not
first uncommented line, edit the file.

13. Restart the services, and troubleshoot any service that does not show a status
of “running.”

manage-modules.cmd service restart all
manage-modules.cmd service status all

Identifier GUID-20AAB559-7574-49C6-8825-E5A027D5491B

Status Released

Configuring virus-scanning software
Running virus-scanning software on directories containing MySQL data and temporary
tables can cause issues, both in terms of the performance of MySQL and the virus-
scanning software misidentifying the contents of the files as containing spam.

After installing MySQL Server, it is recommended that you disable virus scanning on
the directory that is used to store the MySQL table data (such as C:\Program
Files\APG\Databases\MySQL\Default\data). In addition, by default, MySQL
creates temporary files in the standard Windows temporary directory. Configure a
separate temporary directory for MySQL temporary files and add this directory to the
virus scanning exclusion list to prevent scanning the temporary files. To perform this
activity, add a configuration option for the tmpdir parameter to the my.ini
configuration file.

Installing Using the Binary Installer

44 Dell EMC SRM 4.3  Installation and Configuration Guide



Identifier GUID-7B97EB1A-4B25-4A9F-88AC-C2C64279AC0E

Status Released

Configuring binary Dell EMC SRM SRM-Conf-Tools
SRM-Conf-Tools are scripts that are pre-installed on each SRM host in
the /opt/APG/bin directory. These scripts are used to configure the Dell EMC SRM
hosts the same way the vApp version is configured.

The SRM-Conf-Tools scripts use an answers file to automatically configure the Dell
EMC SRM servers. You can use the Dell EMC SRM-Conf-Tools scripts for the
following scenarios:

Procedure

1. Initially configure a Frontend, Primary Backend, and Additional Backend servers.

2. Add new Additional Backend servers to an existing Dell EMC SRM environment.

3. Add Collectors to the Frontend.

If a Dell EMC SRM-Conf-Tools script configuration fails, run it again could
cause a miss-configuration. Clean up the Dell EMC SRM from that VM/Server
and reinstall the product. Refer to Uninstallation on page 67

Identifier GUID-162D4E98-93B0-4132-AE61-0AFF0F4933E1

Status Released

Creating the Dell EMC SRM-Conf-Tools answers file
DELL EMC SRM-Conf-Tools is a command-line utility that can configure and add a
single server or multiple servers to the DELL EMC SRM environment. DELL EMC
SRM-Conf-Tools uses an answers file that you create that includes all of the DELL
EMC SRM hosts in all of the datacenters where DELL EMC SRM is installed.

Before you begin

l The answers file is case sensitive and must be all lowercase.

l Create the file using notepad++ or the Linux VI editor.

l Name the file srm—hosts.

The format of the answers file is: server_type=hostname:os
l server_type -The four basic types of DELL EMC SRM servers

l Hostname -The server's FQDN. It matches the setting of the hostname variable in
the apg.properties file. For Linux servers, it should always be the hostname
plus the domain name (FQDN). For Windows, it could be the hostname
(shortname) or the FQDN depending on how the Windows server resolution is
configured (DNS, Active DNS, or Wins/NetBios). A Wins resolution uses the
hostname (shortname) in uppercase.

l OS -linux-x64 or windows-x64

For example:

frontend=lglba148.lss.emc.com:linux-x64
primarybackend=lglba224.lss.emc.com:linux-x64
additionalbackend_1=lglac142.lss.emc.com:linux-x64
collector_1=lglba150.lss.emc.com:linux-x64
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This answers file can be modified later to add any new Collectors and Additional
Backends. When the DELL EMC SRM-Conf-Tools scripts run, they distinguish new
servers from existing servers and make the necessary configuration changes.

Since the DELL EMC SRM-Conf-Tools and the answers file are used for configuring
additional servers at a later date, DELL EMC recommends storing the files in a /sw
directory in the / directory instead of the /tmp directory. This action should be
performed because the /tmp directory could be deleted at any time.

Identifier GUID-AF89C42B-043A-4AE6-BC95-568C4FED32BF

Status Draft

Installing and configuring the Primary Backend host

Before you begin

l Identify the host that you want to configure as the Primary backend host.

l Identify the hosts that you want to configure as the Frontend, Collectors, and
Additional backends.

l Ensure that you have created an answers file as described in Creating the Dell
EMC SRM-Conf-Tools answers file on page 32.

l Minimum system requirements:

n CPU: 4

n Memory: 24 GB (refer to the DELL EMC SRM design document)

n Disk Space: 132 GB (the final storage size per server is adjusted later)

Procedure

1. The base DELL EMC SRM software and OS updates should be completed as
described in Installing on Linux on page 41.

2. Browse to /opt/APG/bin.

3. Run the Primary Backend configuration script:

./launch-primarybackend-configuration.sh –c /sw/srm-hosts

4. Restart the services and verify that they are running. Troubleshoot any service
that does not show a status of “running.”

./manage-modules.sh service stop all

./manage-modules.sh service start all

./manage-modules.sh service status all

5. Check the DB grants as described in Verifying MySQL DB Grants on page 28.
(Collectors do not need DB grants.)
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Identifier GUID-8BEE1D17-6FA7-45B5-A732-6B5EEB746DCD

Status Draft

Installing and configuring the Additional Backend hosts

Before you begin

l Identify the hosts that you want to configure as the Additional Backend host.

l Identify the hosts that you want to configure as the Frontend, Collectors, Primary
Backends, and Additional Backends.

l Ensure that you have created an answers file as described in Creating the Dell
EMC SRM-Conf-Tools answers file on page 32.

l Minimum system requirements:

n 64-bit Operating System

n CPU: 4

n Memory: 24 GB

n Disk Space: 132 GB (the final storage size per server is adjusted later)

Procedure

1. The base Dell EMC SRM software and OS updates should be completed as
described in Installing on Linux on page 41.

2. Browse to /opt/APG/bin.

3. Run the Additional Backend configuration script:

./launch-additionalbackend-configuration.sh –c /sw/srm-hosts

4. Restart the services and verify that they are running. Troubleshoot any service
that does not show a status of “running.”

./manage-modules.sh service stop all

./manage-modules.sh service start all

./manage-modules.sh service status all

5. Check the DB grants as described in Verifying MySQL DB Grants on page 28.
(Collectors do not need DB grants.)

Identifier GUID-B96AA55D-CB8D-4113-96F7-398BD9B97930

Status Draft

Installing and configuring the Collector host

Before you begin

l Identify the hosts that you want to configure as the Collector hosts.

l Ensure that you have created an answers file as described in Creating the Dell
EMC SRM-Conf-Tools answers file on page 32.
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l Collector to Mega Collector System Requirements:

l 64 bit operating system (Linux or Windows)

l CPU— 4 to 8

l Memory: 16 GB to 64 GB (refer to the DELL EMC SRM design document)

l Disk Space: 132 GB (the final storage size per server is adjusted later)

Procedure

1. Complete the base DELL EMC SRM software and OS updates should be
completed as described in Installing on UNIX and/or Installing on Windows
Server.

2. Browse to .../APG/bin.

3. Run the Collector configuration script:

./launch-collector-configuration.sh –c /sw/srm-hosts

4. Restart the services and verify that they are running. Troubleshoot any service
that does not show a status of “running.”

./manage-modules.sh service stop all

./manage-modules.sh service start all

./manage-modules.sh service status all

5. Because the Generic-RSC and Generic-SNMP modules are installed by default
and if you do not plan to use this collector for host discovery or SNMP
discovery, you can choose to remove these modules, remove these modules:

/.../APG/bin/manage-modules.sh remove generic-snmp

Identifier GUID-47DD7B69-FE8B-4A88-8313-14D80A20904C

Status Draft

Installing and configuring the Frontend host

Before you begin

l Ensure that the configuration for the Primary Backend host is complete before
starting the Frontend configuration.

l Ensure that you have the details of the Frontend host.

l Ensure that you have created an answers file as described in Creating the Dell
EMC SRM-Conf-Tools answers file on page 32

l Minimum system requirements:

l 64-bit Operating System

l CPU: 4

l Memory: 16 GB
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l Disk Space: 132 GB (the final storage size per server is adjusted later)

Procedure

1. The base Dell EMC SRM software and OS updates should be as described in 
Installing on Linux on page 41

2. Browse to /opt/APG/bin.

3. Run the Frontend configuration script:

./launch-frontend-configuration.sh –c /sw/srm-hosts

During the Frontend configuration, the management-resources are configured
on the Primary Backend server. If the DELL EMC SRM ports are not open, then
this configuration script fails with this error: "Some operations failed to run
successfully." Review the logs and fix any errors manually. Refer to Updating
firewall ports in Red Hat and CentOS servers on page 54 to establish the
DELL EMC SRM ports on all the DELL EMC SRM servers. Do not try to run this
script again. Remove DELL EMC SRM from the server where you are running
the script and reinstall DELL EMC SRM. Refer to Uninstallation on page 67

4. Restart the services and verify that they are running. Troubleshoot any service
that does not show a status of “running.”

./manage-modules.sh service stop all

./manage-modules.sh service start all

./manage-modules.sh service status all

5. Verify that the DELL EMC SRM management resources have been created:

 /opt/APG/bin/manage-resources.sh list

The following output shows the management resources on the basis of the
example configuration that is used in the document:

"dba/APG-DB",
  "dba/APG-DB-lglac142-1",
  "dba/APG-DB-lglac142-2",
  "dba/APG-DB-lglac142-3",
  "dba/APG-DB-lglac142-4",
  "dba/FLOW-COMPLIANCE-BREACH",
  "dba/FLOW-COMPLIANCE-CONFIGCHANGE",
  "dba/FLOW-COMPLIANCE-POLICY",
  "dba/FLOW-COMPLIANCE-RULE",
  "dba/FLOW-EVENTS-GENERIC",
  "dba/FLOW-EVENTS-GENERICARCH",
  "dba/FLOW-OUTAGE-DB",
  "dba/FLOW-PROSPHERE-ARCH",
  "dba/FLOW-PROSPHERE-LIVE",
  "dba/FLOW-RPE2-ARCH",
  "dba/FLOW-RPE2-LIVE",
  "dba/FLOW-SOM-ARCH",
  "dba/FLOW-SOM-LIVE",
  "dba/FLOW-UCS-LIVE",
  "dba/FLOW-VIPR-EVENTS",
  "dba/FLOW-VMWARE-EVENTS",
  "dba/FLOW-VMWARE-TASKS",
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  "dba/FLOW-VNX-LIVE",
  "dba/FLOW-WHATIF-SCENARIOS",
  "mgmt/APG-DB",
  "mgmt/APG-DB-lglac142-1",
  "mgmt/APG-DB-lglac142-2",
  "mgmt/APG-DB-lglac142-3",
  "mgmt/APG-DB-lglac142-4",
  "rest/EVENTS",
  "rest/METRICS"

Results

At this point, the basic Dell EMC SRM configuration is complete and you can log in to
the UI. To see the four servers that you just configured, browse to Administration
Discovery > Discovery Center > Manage Discovery.

Identifier GUID-2F2A6D35-DBED-4901-9E94-0A2EE63DD879

Status Released

Scaling-out a Dell EMC SRM environment with Additional
Backend hosts

This process completes the configurations for adding the Additional Backend to the
existing Dell EMC SRM environment using the Dell EMC SRM-Conf-Tools. Additional
Backend hosts should always be on a Linux OS platform.

Before you begin

l Complete the steps that are described in Installing on Linux on page 41.

l Identify the host that you want to configure as the Additional Backend host.

l Get the details of the existing Dell EMC SRM environment that you want to scale.

l Minimum system requirements:

n 64-bit operating system

n CPU: 4

n Memory: 24 GB

n Disk space: 132 GB (the final storage size per server is adjusted later)

Procedure

1. Browse to /opt/APG/bin.

2. Modify the Dell EMC SRM-Conf-Tools answer file (srm-hosts) as described
in Creating the Dell EMC SRM-Conf-Tools answers file on page 32.

3. Add the new Additional Backend to the original srm-hosts file in the /sw
directory.

In the example, additionalbackend_2 is the new Additional Backend.

frontend=lglba148.lss.emc.com:linux-x64
primarybackend=lglba224.lss.emc.com:linux-x64
additionalbackend_1=lglac142.lss.emc.com:linux-x64
additionalbackend_2=lglac143.lss.emc.com:linux-x64
collector_1=lppd149.lss.emc.com:linux-x64
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4. Copy the modified answer file (srm-hosts) to these Dell EMC SRM Frontend,
Primary Backend, and Additional Backends. (The modified file is not needed on
the existing Collector servers.)

5. Browse to /opt/APG/bin.

6. To configure the new Additional Backend host, run the following script:

launch-additionalbackend-configuration.sh –c /sw/srm-hosts

7. Restart the services and verify that they are running. Troubleshoot any service
that does not show a status of “running.”

./manage-modules.sh service stop all

./manage-modules.sh service start all

./manage-modules.sh service status all

8. Run the following script on all existing Additional Backend hosts:

./launch-additionalbackend-scale-additionalbackend.sh –c / sw/
srm-hosts

9. Run the following script on the Primary Backend host:

./launch-primarybackend-scale-additionalbackend.sh –c / sw/
srm-hosts

10. Run the following script on the Master Frontend host:

./launch-frontend-scale-additionalbackend.sh –c / sw/srm-hosts

11. List the Management Resources to verify that the Additional Backends hosts
were added:

./manage-resources.sh list

In this example configuration, the following entries would be added to the list of
resources:

"dba/APG-DB-lglba250-1",
  "dba/APG-DB-lglba250-2",
  "dba/APG-DB-lglba250-3",
  "dba/APG-DB-lglba250-4",

  "mgmt/APG-DB-lglba250-1",
  "mgmt/APG-DB-lglba250-2",
  "mgmt/APG-DB-lglba250-3",
  "mgmt/APG-DB-lglba250-4",

12. Restart all of the services on the Additional Backend servers, Primary Backend
server, and Frontend Server.
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13. Log in to Dell EMC SRM and confirm that the new Additional Backend is in the
UI.

Results

The Additional Backend hosts are added to the existing Dell EMC SRM configuration.
To see the five servers that you have configured, browse to Administration
Discovery > Discovery Center > Manage Discovery.

Identifier GUID-EAD4CD3F-D2FE-4C03-BF2E-8C825B045848

Status Released

Scaling-out a Dell EMC SRM environment with Collector
hosts

This process completes the configurations for adding Collector hosts to the existing
Dell EMC SRM environment using the SRM-Conf-Tools. Collector software can be
installed on a Linux or Windows platform. (Currently the Hyper-V SolutionPack
requires a Windows platform.)

Before you begin

l Complete the steps that are described in Installing on Linux on page 41 and/or 
Installing on Windows Server on page 43

l Identify the host that you want to configure as the Collector host.

l Get the details of the existing Dell EMC SRM environment that you want to scale.

l Minimum System Requirements:

n 64-bit operating system

n CPU: 4 to 8

n Memory: 16 GB to 64 GB (refer to the Dell EMC SRM design document)

n Disk space: 120 GB (the final storage size per server is adjusted later)

Note

For Windows, convert .sh to .cmd for the commands and / to \ for directories.

Procedure

1. The base Dell EMC SRM software and OS updates should be completed as
described in Installing on Linux on page 41 or Installing on Windows Server on
page 43

2. Browse to .../APG/bin.

3. Modify the Dell EMC SRM-Conf-Tools answer file (srm-hosts) as described
in Creating the Dell EMC SRM-Conf-Tools answers file on page 32

4. Add the new collector to the srm-hosts file.

In the example, collector_2 is the new Collector.

frontend=lglba148.lss.emc.com:linux-x64
primarybackend=lglba224.lss.emc.com:linux-x64
additionalbackend_1=lglac142.lss.emc.com:linux-x64
additionalbackend_2=lglac143.lss.emc.com:linux-x64
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collector_1=lppd149.lss.emc.com:linux-x64
collector_2=lglba150.lss.emc.com:linux-x64

5. Copy the modified answer file (srm-hosts) to the Dell EMC SRM Frontend
(This new file is not needed on the existing Dell EMC SRM servers.)

6. Browse to .../APG/bin.

7. To configure the new Collector host, run the following script:

./launch-collector-configuration.sh –c /sw/srm-hosts

8. Restart the services and verify that they are running. Troubleshoot any service
that does not show a status of “running.”

./manage-modules.sh service stop all

./manage-modules.sh service start all

./manage-modules.sh service status all

9. Run the following script on each Frontend:

./launch-frontend-scale-collector.sh –c / sw/srm-hosts

Results

The Collector hosts are added to the existing Dell EMC SRM configuration. To see the
six servers that you have configured, browse to Administration Discovery > Discovery
Center > Manage Discovery.

Identifier GUID-5357B345-5A8F-4260-BF9B-2F91C2FD7E92

Status Draft

Verifying MySQL DB Grants
After installing and configuring the DELL EMC SRM hosts, cross check the grant
privileges that are configured for the DELL EMC SRM servers that are listed in the
SRM-Conf-Tools configuration file.

Database grants for Collector hosts are not required.

Where the scripts configure grants for Collector hosts, it is not needed and can be
ignored or deleted.

Procedure

1. Run the following script:

/opt/APG/bin/mysql-client.sh 

2. When prompted, select root as the username, mysql for the database, and
watch4net as the password.
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3. Run the following query:

mysql> SELECT user, host, db, select_priv, insert_priv, 
grant_priv FROM mysql.db;

The following table is an example of the configuration you should see on an Additional
Backend host:

Identifier GUID-205582F3-3EEF-425A-A6A5-21DBE250EC86

Status Released

Updating firewall ports in Red Hat and CentOS servers
The Red Hat and CentOS operating systems are installed by default with the OS
firewall (firewalld) locked down. Only a few basic ports are open (such as SSH). On
these operating systems, the firewall must be modified to allow the DELL EMC SRM
ports.

Procedure

1. Using a Linux editor, create an xml file and save it as apg.xml in the /etc/
firewalld/services directory.

2. Add the following text to the xml file:

<?xml version="1.0" encoding="utf-8"?>
<service>
  <short>TEST</short>
  <description>Add DELL EMC SRM Ports to Red Hat and CentOS 
Firewall</description>
  <port protocol="tcp" port="58080"/>
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  <port protocol="tcp" port="2000"/>
  <port protocol="tcp" port="2001"/>
  <port protocol="tcp" port="2100"/>
  <port protocol="tcp" port="2101"/>
  <port protocol="tcp" port="2200"/>
  <port protocol="tcp" port="2201"/>
  <port protocol="tcp" port="2300"/>
  <port protocol="tcp" port="2301"/>
  <port protocol="tcp" port="2400"/>
  <port protocol="tcp" port="2401"/>
  <port protocol="tcp" port="2003"/>
  <port protocol="tcp" port="2008"/>
  <port protocol="tcp" port="2009"/>
  <port protocol="tcp" port="2010"/>
  <port protocol="tcp" port="2012"/>
  <port protocol="tcp" port="2020"/>
  <port protocol="tcp" port="2022"/>
  <port protocol="tcp" port="2040"/>
  <port protocol="tcp" port="2041"/>
  <port protocol="tcp" port="5480"/>
  <port protocol="tcp" port="5488"/>
  <port protocol="tcp" port="5489"/>
  <port protocol="tcp" port="8082"/>
  <port protocol="tcp" port="8189"/>
  <port protocol="tcp" port="8888"/>
  <port protocol="tcp" port="8889"/>
  <port protocol="tcp" port="9996"/>
  <port protocol="tcp" port="22000"/>
  <port protocol="tcp" port="22020"/>
  <port protocol="tcp" port="22020"/>
  <port protocol="tcp" port="48443"/>
  <port protocol="tcp" port="52001"/>
  <port protocol="tcp" port="52004"/>
  <port protocol="tcp" port="52007"/>
  <port protocol="tcp" port="52569"/>
  <port protocol="tcp" port="52755"/>
  <port protocol="tcp" port="53306"/>
  <port protocol="tcp" port="58005"/>
  <port protocol="tcp" port="389"/>
  <port protocol="tcp" port="58443"/>
  <port protocol="tcp" port="5988"/>
  <port protocol="tcp" port="5989"/>
  <port protocol="tcp" port="5986"/>
  <port protocol="tcp" port="80"/>
  <port protocol="tcp" port="443"/>
  <port protocol="tcp" port="8080"/>
  <port protocol="tcp" port="2707"/>
  <port protocol="tcp" port="8443"/>
  <port protocol="tcp" port="2443"/>
  <port protocol="tcp" port="4443"/>
  <port protocol="tcp" port="2682"/>
  <port protocol="tcp" port="1521"/>
  <port protocol="tcp" port="9004"/>
  <port protocol="tcp" port="9002"/>
  <port protocol="tcp" port="7225"/>
  <port protocol="tcp" port="58083"/>
  <port protocol="tcp" port="52755"/>
  <port protocol="tcp" port="2060"/>
  <port protocol="tcp" port="3682"/>
  <port protocol="udp" port="161"/>
  <port protocol="udp" port="162"/>
  <port protocol="udp" port="2040"/>
  <port protocol="udp" port="2041"/>
</service>

3. Copy the apg.xml file to the /etc/firewalld/services directory.
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4. To add the ports to the existing firewall run the following command:

firewall-cmd --permanent --add-service=apg

5. Check the status of firewalld:

systemctl status firewalld

Identifier GUID-B7237D6A-36A8-4132-B010-952A4D6A4D6B

Status Draft

Editing new actions scripts
It states that the Frontend Server where the "Actions" directory exists may need to
be modified to point to the Primary Backend Server .

Procedure

1. In the 'conf' file, replace 127.0.0.1 with the primary backend IP address or
FQDN:

Option Description

Linux /opt/APG/Custom/WebApps-Resources/Default/
actions/event-mgmt/linux/conf

Windows Program Files\APG\Custom\WebApps-Resources
\Default\actions\event-mgmt\windows\conf.cmd

Identifier GUID-D7F4BCBF-3702-4318-9FAA-F387A2EA157B

Status Released

Verifying that the services are running
Verify that the services are running on each host by obtaining the status.

Before you begin

Ensure that you have a login with root, APG, or system administrator privileges. The
user apg is the account that the application uses instead of root.
Procedure

1. Type the command for the operating system from the bin directory of the
installation:

Operating system Command

UNIX manage-modules.sh service status all
Windows manage-modules.cmd service status all

2. Verify that each service has a status of running in the output.
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Identifier GUID-1583428A-EF9C-4231-AFD2-4565B6B30C8D

Status Released

Troubleshooting service start-up problems on UNIX
Check the log files when services do not start.

Before you begin

Ensure that you have logged in with root to check the log files.

Procedure

l The default path is /opt/APG/.

The list of available log files vary depending on the type of server (Frontend,
Backend, or Collector).

Databases/MySQL/Default/data/[SERVER NAME].err
Backends/Alerting-Backend/Default/logs/alerting-0-0.log
Backends/APG-Backend/Default/logs/cache-0-0.log
Collecting/Collector-Manager/Default/logs/collecting-0-0.log
Web-Servers/Tomcat/Default/logs/service.log
Tools/Task-Scheduler/Default/logs/scheduler-0-0.log
Tools/Webservice-Gateway/Default/logs/gateway-0-0.log

Identifier GUID-0B538AA5-D52A-4F85-B8C3-118C2F10AC40

Status Released

Troubleshooting service start-up problems on Windows
Check the log files when services do not start.

Before you begin

Ensure that you have logged in with system administrator credentials to check the log
files.

Procedure

l Look for log files in these C:\Program Files\APG directory paths.

The list of available log files vary depending on the type of server (Frontend,
Backend, or Collector).

Databases\MySQL\Default\data\[SERVER NAME].err.
Backends\Alerting-Backend\Default\logs\alerting-0-0.log
Backends\APG-Backend\Default\logs\cache-0-0.log
Collecting\Collector-Manager\Default\logs\collecting-0-0.log
Web-Servers\Tomcat\Default\logs\service.log
Tools\Task-Scheduler\Default\logs\scheduler-0-0.log
Tools\Webservice-Gateway\Default\logs\gateway-0-0.log
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Identifier GUID-8FEC494A-097B-4727-AC1D-F57FDFF85165

Status Released

Logging in to the user interface
Log in to the user interface to use and edit reports, manage users, and customize the
interface to meet the needs.

Procedure

1. Open a browser and type the following URL:

https://<Frontend-hostname>:58443/APG
2. Type the login credentials.

The default username is admin. The default password is changeme.

3. Click Sign In.

Note

You are automatically logged off after 4 hours.

Identifier GUID-E9BB4081-41B7-4BD2-8448-B2DC480ED1B8

Status Draft

Connecting to Administration
Connect to the server so that you can access Administration to install and administer
SolutionPacks.

Administration is one of the multiple web applications available in Dell EMC M&R
platform.

Procedure

1. Open a browser.

2. Type https://<Frontend-host-IP>:58443/administration.

Example:

https://myHost.emc.com:58443/administration

3. Log in.

Default username is admin.Default password is changeme.

4. Click Sign In.

You are automatically logged off after 4 hours.

Installing Using the Binary Installer
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CHAPTER 7

Automating the Download of Updates

This chapter includes the following topic:

l Online Update overview..................................................................................... 60
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Online Update overview
Online Update automatically downloads the latest versions of the SolutionPacks and
Dell EMC M&R components from the Dell EMC Update server to the Module
Repository on the Administration server.

In a multi-server environment, the downloaded modules are distributed to all of the
remote servers that the CM server manages.

Identifier GUID-405D8E3E-510D-497B-9AD2-F26E9DCB58C2

Status Draft

Configuring server settings for online updates
Procedure

1. Click Administration .

2. Navigate to System Admin > Settings > Manage Online Update.

3. Ensure that you are on the Settings tab.

4. Check the Enabled checkbox.

5. Type the Dell EMC Online Support username and password.

6. To test connectivity to the update server, click the  icon.

The  icon indicates that connectivity to the server has been established.

The  icon indicates that connectivity to the server failed.

7. Click Save.

Identifier GUID-54658688-062C-423B-BFFF-379EFF83D417

Status Draft

Enabling the online update task
Enable the Online Update task to download the latest updates from the Dell EMC
Update server automatically.

Procedure

1. Click Administration > Home.

2. On the Physical Overview page, click <host_name> -Front End where the
Online Update task has to run.

3. Click Tasks.

4. Type OnlineUpdate in the Search bar.

5. Click the OnlineUpdate to run the scheduled task.

6. Click Enable.

Automating the Download of Updates
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Note

By default, this task is set to run once everyday at 12AM. You can customize
the task schedule by editing the configuration file.

Identifier GUID-BFC2E850-3B87-42BB-9668-FF23E5E20E91

Status Draft

Running the online update task manually
At any time, you can run the Online Update task manually to access the available
updates.

Procedure

1. Click Administration > Home.

2. On the Physical Overview , click the <host_name> - Front End where the
Online Update task has to run.

3. Click Tasks.

4. Type OnlineUpdate in the Search bar.

5. Click the OnlineUpdate scheduled task.

6. Click Run Now.

Identifier GUID-03BED1E1-701C-4473-9068-A0588E1FF129

Status Draft

Online Update Status
The Online Update Status tab indicates if the last online update check was
successful or not, provides the date and time of the last successful check, and lists
any updates that are available for download.

Figure 1 Online Update Status

If a major update of the Dell EMC M&R platform is detected, the Status tab is
included with a Major Update Status section that describes that the version that is
available. It provides a link to the upgrade documentation, and includes a Start
Download button.
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Figure 2 Online Update Status with a major version update detected

Identifier GUID-FAF4D46F-5D38-48D3-906E-B4FC9E30DFFF
Status Draft

Downloading a major update
You can use Online Update to download a major version of the Dell EMC M&R
platform. If you intend to immediately complete the full upgrade process, download
only a major version.

Procedure

1. Click Administration.

2. Click System Admin.

3. Click Settings > Manage Online Update.

4. Click the Status tab.

5. Click Start Download. When the download is finished, the Download State
changes from "Not Downloaded" to "Complete."

6. Complete the upgrade process as described in the upgrade documentation.
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Status Draft

Online Update History
The Online Update History tab provides a download history with the names of the
components, the version numbers, and the date and time of the downloads.

The History tab also allows you to search the download history for a particular
component name or version number.

Identifier GUID-383778A8-0D82-4F0F-A2A3-E94C01368850

Status Released

Disabling the online update task
If you prefer to manually download the updates from the Dell EMC Update server, you
can disable the Online Update task.

Procedure

1. Click Administration > Home.

2. On the Physical Overview page<host_name>- Front End, click the where the
Online Update task has to run.

3. Click Tasks.

4. Type OnlineUpdate in the Search bar.

5. Click the OnlineUpdateto run the scheduled task.

6. Click Disable.

Identifier GUID-D7CC01FD-5F10-4796-B6F7-D2B2C4FE2A5F

Status Draft

Upgrading the system without using Online Update

Procedure

1. Go to the Support by Product page for DELL EMC SRM (https://
support.emc.com/products/34247_ViPR-SRM).

2. Click Downloads.

3. Download the core update file for each of the deployed architectures. The vApp
file also contains the appliance update file for vApp deployments.

Table 3 Update files for Linux and Windows platforms

Option File Title File Name

Linux (vApp) ViPR SRM<Version Number> vApp Update
for System Upgrade UI

ViPR_SRM_<version_number>_vApp_Upd
ate_UI.zip

Linux (binary only) ViPR SRM<Version Number> Linux Update ViPR_SRM_<version_number>_Linux_64-
bit_Update_File.zip

Windows ViPR SRM <Version Number> Windows
Update

ViPR_SRM_<version_number>_Windows_
64-bit_Update_File.zip

4. From Administraton System Admin, click System Operations > Update
System.
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5. Click the Browse button (or buttons for mixed environments) and provide the
upgrade files for the platforms.

6. Click Upload Content.

7. The system displays a message about ensuring that there is minimum of 5 GB
disk space on the servers. Click OK.

The system upgrade files are uploaded to Administration and non-disruptively
distributed to all of the servers in the deployment. This process may take
several minutes.

8. When you are ready to go with the upgrade, click Go to maintenance mode.

Maintenance mode begins, the front end becomes unavailable, and after a short
wait you are redirected to the Platform Upgrade page. Any users who try to
access the front end receives a message that it is in maintenance mode and has
been temporarily disabled.

9. When the system has completed the validation checks, copy the URL from the
message in the highlighted text, and then click Launch upgrade.

The system validates the status of the servers, prepares for the upgrade, and
begins upgrading the modules.

Automating the Download of Updates
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When the upgrade is complete, the system displays a green check mark next to
each node and a success message at the top of the window.
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10. Click Exit.

The system restarts the front end and redirects you to the SolutionPack UI.
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CHAPTER 8

Uninstallation

This chapter includes the following topics:

l Overview............................................................................................................68
l Stopping Dell EMC M&R platform services on a UNIX server............................ 68
l Uninstalling the product from a UNIX server......................................................68
l Stopping Dell EMC M&R platform services on a Windows server...................... 69
l Uninstalling the product from a Windows server................................................69
l Uninstalling a SolutionPack................................................................................ 70
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Overview
You can uninstall a SolutionPack and uninstall Dell EMC M&R platform from a UNIX or
Windows server.

Stop the Dell EMC M&R platform services before uninstalling Dell EMC M&R
platform.

Identifier GUID-4EBE8447-E24E-4FF7-9E43-D5C817F410E1

Status Released

Stopping Dell EMC M&R platform services on a UNIX server
Use the manage-modules.sh service stop command to stop a specific Dell
EMC M&R platform service or to stop all Dell EMC M&R platform services on a UNIX
server.

Before you begin

Ensure that you have logged in with root or APG privileges.

Note

The list of services varies depending on which type of installation was performed,
vApp, collector, backend, and frontend.

Procedure

l Type manage-modules.sh service stop <service_name> from the bin
directory of the installation to stop a specific Dell EMC M&R platform service.

This example shows how to stop all Dell EMC M&R platform services:

./manage-modules.sh service stop all 

Identifier GUID-12551740-6297-4CF0-A54E-ACC7AD9CF09F

Status Released

Uninstalling the product from a UNIX server
Before you begin

Ensure that you have a login with root privileges.

Procedure

1. Type rm -rf /opt/APG to remove the installation directory.

2. Restart the server.

Uninstallation
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Stopping Dell EMC M&R platform services on a Windows
server

Use this procedure to stop Dell EMC M&R platform services from the Windows
desktop.

Before you begin

To manage services, ensure that you have logged in with system administrator
credentials.

Note

The list of services varies depending on which type of installation was performed,
vApp, collector, backend, and frontend.

Procedure

1. Type manage-modules.cmd service stop <service_name> from the bin
directory of the installation to stop a specific Dell EMC M&R platform service.

This example shows how to stop all Dell EMC M&R platform services:

./manage-modules.cmd service stop all 

Identifier GUID-3778F1A9-9D41-4885-8FA4-BEE5B32E1D35

Status Released

Uninstalling the product from a Windows server
Before you begin

Ensure that you have logged in with system administrator credentials.

Procedure

1. Use the Windows Control Panel to uninstall the product.

a. Click Start > Control Panel > Programs.

b. Click Uninstall a program.

c. Select the Watch4net Solutions APG and click Uninstall.

2. Restart the server.

Uninstallation
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Uninstalling a SolutionPack
If you no longer want to view the reports of a certain SolutionPack, you can uninstall
that SolutionPack from the server.

Procedure

1. Log in with administrator credentials for Dell EMC M&R platform and select
Administration.

2. Select Discovery in the Administration tree.

3. Select SolutionPacks in the tree.

4. Select the SolutionPack that you want to uninstall in the Installed
SolutionPacks screen.

5. In the Properties area, click Trashcan icon for each instance of the
SolutionPackBlock and click Remove.

Uninstallation
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APPENDIX A

Telnet and Socket Interface Ports

This appendix includes the following topic:

l Telnet and socket interface ports for each backend...........................................72
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Telnet and socket interface ports for each backend
The Telnet and Socket interface for each backend must be different on that backend
host. These ports are open in the Linux firewall setting by default.

Table 4 Telnet and Socket Details

Backend Host Backend Socket interface Telnet interface

Primary Backend
(PBE)

DB 2000 2001

Additional Backend #1
(ABE)

DB1 2100 2101

DB2 2200 2201

DB3 2300 2301

DB4 2400 2401

Additional Backend
#2 (ABE)

DB-hostname-1 2100 2101

DB-hostname-2 2200 2201

DB-hostname-3 2300 2301

DB-hostname-4 2400 2401

Additional Backend
#3 (ABE)

DB-hostname-1 2100 2101

DB-hostname-2 2200 2201

DB-hostname-3 2300 2301

DB-hostname-4 2400 2401

Additional Backend
#4 (ABE)

DB-hostname-1 2100 2101

DB-hostname-2 2200 2201

DB-hostname-3 2300 2301

DB-hostname-4 2400 2401

Additional Backend
#5 (ABE)

DB-hostname-1 2100 2101

DB-hostname-2 2200 2201

DB-hostname-3 2300 2301

DB-hostname-4 2400 2401

Additional Backend
#6 (ABE)

DB-hostname-1 2100 2101

DB-hostname-2 2200 2201

DB-hostname-3 2300 2301

DB-hostname-4 2400 2401
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APPENDIX B

SolutionPack Reconfiguration Fields

This appendix includes the following topic:

l SolutionPack Reconfiguration Fields.................................................................. 74
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SolutionPack Reconfiguration Fields
You can change the settings for the SolutionPack from the SolutionPack
Reconfiguration page.

Table 5 SolutionPack Reconfiguration Fields

Field Description

Socket Collector port On this TCP port on the Primary Backend, the
Arbiter is accepting the remote connections
from all LBCs.

APG Backend hostname or IP address The hostname of the server where the apg
database and its backend service are running.
In this deployment, the possible options are
backend and backend2. Do not use
"localhost" for the default apg on the primary
backend.

APG Backend data port Each APG has a backend and each backend
has its own TCP port to receive raw data. The
port must be unique only inside the server.
Refer to Installing and Configuring the
Additional Backend hosts. In this installation,
the ports are 2000, 2100, 2200, 2300 and
2400.

Web-Service Gateway Each APG server has a Web-Service
Gateway. This hostname must point to the
APG server with the backend service.

Backend Web-Service Instance The backend instance name. In this
deployment, the possible values are:

l Default (the default backend instance
name from primary backend)

l apg1

l apg2

l apg3

l apg4

Backend database type MySQL by default.

Backend database hostname or IP address The hostname where the MySQL database is
running. By default, it is same as the APG
Backend hostname.

Backend database port number The port on which MySQL is accepting
remote TCP connections. By default, it is
53306.
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Table 5 SolutionPack Reconfiguration Fields (continued)

Field Description

Backend Database name The database name that is used in MySQL.
For example, apg, apg1, apg2.

Backend database username The user who is configured in MySQL. The
default is "apg"

Backend database password The default password for the MySQL user is
"watch4net"
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APPENDIX C

Unattended Installation

This appendix includes the following topics:

l Unattended installation...................................................................................... 78
l Unattended installation arguments for Linux...................................................... 78
l Unattended installation arguments for Windows................................................ 79
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Unattended installation
EMC M&R 6.7 and higher supports fully unattended installations, which are
particularly useful for installing the software on remote systems via scripts. This
appendix describes the installation of the platform software, but it does not include
the installation and configuration of modules or SolutionPacks.
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Unattended installation arguments for Linux

l --silent
Runs the setup script in unattended mode. No questions are asked, and the default
settings are used.

l --accept-eula
Accepts the EULA. By providing this switch, you are confirming that you have read
and accepted the EULA.

l --install-dir=<path to installation>
Overrides the default installation location. The default is typically /opt/APG.

l --user=username
Overrides the default user for installation of the servers. The default is typically
apg.

l --script-directory=initd_directory
Overrides the default script directory. The default is /etc/init.d.

l --runlevel-directory=rcd_directory
Overrides the default runlevels directory (containing rc[0-6].d/).

The default is /etc.

l --install-type=installation_type
Overrides the default installation type. The available options are default, minimal,
collector, backend, and frontend. The command only considers the first letter, so
--install-type=C is equivalent to --install-type=collector. The value
of the parameter is not case sensitive.

Example 1  To override the default installation and set the installation type to collector:

[root@server ~]# ./linux_setup.sh -- --install-type=collector

Example 2  To run a fully unattended installation and install as a collector in an alternate
directory:

[root@server ~]# ./linux_setup.sh -- --accept-eula --silent --
install-type=collector --install-dir=/opt/SRM
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Unattended installation arguments for Windows

l /S
Runs the setup script in unattended mode. No questions are asked, and the default
settings are used. It must be the first argument.

l ACCEPTEULA =Yes
Accepts the EULA. By providing this switch, you are confirming that you have read
and accepted the EULA. If you have not accepted the EULA, the installer refuses
to run in unattended mode.

l INSTALL-TYPE=installation_type
Overrides the default installation type. The available options are: default, minimal,
collector, backend, and frontend. The command only considers the first letter, so
INSTALL-TYPE=C is equivalent to INSTALL-TYPE=collector. The value of
the parameter is not case sensitive.

l /D
Sets the default installation directory. It must be the last parameter. It cannot
contain any quotes (even if the path contains spaces), and only absolute paths are
supported.

Example 3  To run a fully unattended installation and install as a collector in an alternate
directory:

C:\Users\user1> windows_setup.exe /S /D=C:\SRM /
ACCEPTEULA=Yes /INSTALL-TYPE=collector
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